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(For reference — in the first lab, start by usit®D4 Oracle Familiarisation session’)

1. Oraclein the IT Lab

1.1 Introduction
The full Oracle system, which is used in the IT Liaba Client-Server system, i.e.:
* There is one database on one machine;

¢ This one machine runs a server process which mareggatabase access;
« Other machines (possibly including the server maghiun processes which are
sessions connecting the user to a database

There is also Personal Oracle, in which all thisgees on one machine. We nigt have
Personal Oracle in the IT Lab.

In the IT Lab the server should be running all tinee — an error message alerts you if the
server is broken.
You have to logon to the database for each Orané t

1.2 In the IT Lab
« Each machine in the IT Lab is an Oracle client.

* The Oracle Software on each PC enables connedtitiretOracle databa#e which is
held on the serverrooked.

* Each user can create their own schema intfi@edatabase, their schema is identified
by their username.

* The sql command files, loader files etc. shouldkéet in your XP workspace ds4.
In the DBS course you will use Aqua Data Studio

« to enter SQL statements to create your tables,s/&wd indices, to insert some
data, and subsequently to extract subsets of tiag(daeries);

¢ to bulk load data;
« to create, edit and view tables, indexes etc.
o The Table Editor within the tool is useful for vigwg and editing data.

On of the aims of the course is that you shouldware of the basic SQL commands even
if you sometimes use a Manager to simplify somegsses.
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1.3 Documentation

Our intention is to supply you with all the infortiean that you need for the DBS module.
Additionally, each Oracle application has help.efkhis also a lot of documentation
accessible from\fs4\Oracle 10g_docs (index.htm), accessible from the course
website. There is also a link to it from the Staenu. You may wish to refer to this to
clarify or extend the information that we have digigh The sections that are of particular
interest are

SQL Reference

SQL Plus Users Guide

2. Aqua Data Studio

2.1 Introduction

Aqua Data Studio is an integrated tool that allgas to manage, using a GUI, from a
unified view:
» Schemas
o Create, alter, drop and show dependencies of scbbjaets (i.e. tables,
indexes, views). You will use this.
e Security
o Allows authorised administrators to create, altet drop users, roles and
profiles, and grant privileges and roles to datahasers. You will only use this
to alter your password.
e Many others...
o You will not use these, although some topics wélldovered later in the
course.
Your schema is identified by your username.

2.2 Opening Aqua Data
» ChooseStart: All Programs: Aqua Data Studio: Aqua Data Studio

* Registering a server:
0 When you start the program for the first time, ydll be asked if you wish to
register a database server. Click on yes.
o If you do not get such a prompt, click on menu ifenver: Register Server

* Now, you get a new window where you have a liglitferent Database Management
Systems (See Screenshot on next page). Sé€eatle 9i/10g’ and enter the
following data in the form on the right hand side:

o Name:crooked
o0 Login Name <your Oracle username is yourWindowsUsername>
o Password: <Your initial Oracle password is yourWavesUsername >
= Case is not important
o Port:1521
Host: crooked
o SID:it08

o
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Fils

« If the connection is successful, you will see adidlocal Database Servers on the left
hand side of the interface (as you are only comukitt crooked, you will see only this
server in the list)
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2.3 Changing your Password

We recommend you to use the Security Manager ¢o wdiur password. Therefore, click
onDBA Tools: Oracle: Security Manager and connect to the server. Now, select
your username out of the navigation tree and ditkhe ‘Alter User’ icon on the top of
this tab. Here, you can alter your password. Rebeero click on OK after entering your
password twice Remember also to remember your new password!

In the familiarisation session, go back to the ora handout now.

2.4 The Query Analyser

In Agqua Studio Plus, you can run client-side seripat contain SQL commands using the
Query Analyser. Click oferver: Query Analyser to open the worksheet. It looks like
this:
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= Agqua Data Studio 4.7.2 [Untitled]
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Within the Query Analyzer window you can createeavruery, open a script, save a
query, save a query as, save results, print, pexgeute current, and execute edit. The
toolbar allows you to find and replace, enable aampletion, refresh the auto schema
and set the maximum results displayed. You cacktyuchange the database you are
analyzing in the dropdown menu above the edit windo

Separate your statements with "GO" or "/" - To emtly use all of Query Analyzer's
functionality you need to separate your SQL Statésnd his allows Aqua Data Studio to
quickly identify which statement you are workingsorthat it may intelligently provide
Auto-Completion, Describe, SQL Template, and Exeasita script on the current
statement. If you do not do this you might geirtiression that Aqua Data Studio
doesn't work.

2.4.1 Running a Previously Created Script

Display the script in the Query Analyser, then BExecThis method has the advantage
that you can alter and save the script if necessag errors are clearer to spot in the
output.
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1. Clear the input if required by clicking into thergawith the right mouse button and
then choosing: Clear Document.

2. Selecting the File: Open Script item displays ttamdard file selection dialog box.

3. After you select the file and click Open, the caontef the script appears in the input
pane.

4. Click the Execute Icon or select the Query: Exedeta to run the script. You can
also run the script in using the shortcut Ctrl.-E.

5. The output will appear in the output pane.

In the familiarisation session, go back to the ora handout now.

2.4.2 Running a new SQL command

« Clear the input and output panes if required bgkatig into the pane with the right
mouse button and then choosing: Clear Document.

* Type the SQL command into the input pane of therAealyser.

* Click the Execute button.

« The result of the query is displayed in the lowmrtput) pane.

2.4.3 Creating a Command File

You will probably want to keep a copy of many ofiy&QL commands. We suggest the

following approach:

« Enter the SQL command in the input pane of the @Aealyser. Don't forget the go
at the end. Test it.

¢ Include comments.

* When itis correct, usle: Save Query As... to save the command in your own
workspace with a meaningful name and the extensain You can also use the disc
icon in the worksheet to save your query.

« If you are creating a file containing several comds such as
CreateAllTables.sql, you should create it incrementally, testing ee@immand one
by one.

2.4.4  Saving and printing results of a command

The results of a query run can be written to adngFile: Save Results, which can be
then opened in WordPad and printed.

Alternatively, you can copy and paste selectedftext the output pane into a document
of your choice.

2.45  SQL History

Clicking onQuery: SQL History, you can find SQL commands that you executedezarli
in the same session.
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2.5 Schema Settings

251 Viewing Tables in the Schema Browser

With Agua Data Studio, you can create, edit andréna schema objects such as tables,
indexes, sequences and procedures. In DBS, weisdlthe SQL CREATE commands to
create schema objects, and we will only use thei®ehManager of Aqua Data Studio to
examine these objects and possibly make minor @sang
« Navigate to your tables under your username irSttfeema Browser listed under
the database server in the left hand side of tieefate.
* Make a right mouse click on the name of the tablg.(Branch) and choo3$eble
Properties
¢ Column names, data types and sizes are specified he
* Click on theConstraints tab to view the Constraints. Click on each constraint
to see the details in the lower pane. You may neellag the borders to see the
contents of th&€heck Conditiorgolumn.

[ETEEEA & consvares |

oL@ & DR ¢ % 4% Constraint on Table:

PIEERO Gaae BEEF &

||| cotebeses (=] schernes [cermer: | sermane: hopfgaf AUDSID: 230322

Ref schema Ref Table | Check Candition

(‘Braddress" 15 N,

Constraint Defirition

Table Calurns Referenced Columns

| 2:1 " [ws] (25/10/06 16:33:28 BST Script executed - (1) Error...

close.

25.2 Editing tables in the Schema Manager

Right click on the Tables folder on the left haitksof the interface andhoose
Create Table. This brings up a table similar to that show2ib2, but one which can
be edited. Make any alterations and click OK.

2,53 Viewing, entering and editing data using the Table Editor

Right click on a name of a table in the navigatime and choosedit Table Data (Top
1000), which allows you to display, update and deletecttrgtents of a Table. The same
changes can be done for the View of a table.
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2.6 Printing

Printouts might contain far more information thaa meed. You may find a subsection
useful (e.g. copy and paste relevant parts intod/ftar printing) For the assessment of
your table definitions, we would like to see yolREATE TABLE commands.

2.7 Importing data from afile

You can use the Aqua Data Studio to import datan fectext file.

¢ SelectTools: Import Data from the Menubar. This will prompt you to choase
server in which to import data into. Navigate aetect your server and click ok.
This will bring up the Import dialog

« The first tab in the wizard is the General Tabrstribrowse and select the file you
want to import. Once the file is selected a sampkbe file will be displayed in the
bottom grid. Then select the encoding and platfgour file is formatted in. The
sample columns will be refreshed as you make clsatoggour options. Select
whether your file is delimited or has fixed widtblemns. If your file has fixed width
columns, type the widths of your columns separatedommas (eg: 15,25,35,60 ).
While typing the column widths the sample data wit change, so make sure to click
on the Fixed Width radio box to refresh. You melest whether the first row in the
file contains the column names to help the impmot tap to the table. Last, select
the quote identifier for your data values. Makeeghe sample data being displayed is
formatted correctly before proceeding, then cliektrto go on to the next tab.

« With the Format Tab, you may now select the dambschema and table in which
you want to import the data into. If you woulddiko import into a new table, you
may click on the "..." button which will open a @te Table dialog with the columns
defined in the sample file. You may change theemand datatypes of the columns
in the table and then click ok. At this point ymay import into the newly created
table. If the sample file contains the column naikethe values, ADS will make an
attempt at matching the column names of the imfderto the names of the columns
of the table. You may reorder the column mappipghenging the Position column
value to match the column number in the sampledile/ou may remove the position
value to exclude the column from being importechc®all columns are mapped click
next.

« In the Options Tab you may begin by selecting wleytou want "(null)" text values
to be converted to NULL values. Then you mustctdlee format of the dates & time,
date and time values will be formatted in the fé&tto be imported into date/time
columns. If a date string is to be imported intdARCHAR column then the format
does not apply. You also have the option to imgwoectly into the database, or
generate an SQL file with INSERT statements to irhpto the database. A sample
of the files values are provided below for configgrthe date/time formats. When
ready, you may click the Next button to import tfega.

¢ Once in the Status Tab the import has begun. Yayeancel the import at any time
by clicking on the cancel button at the bottomhef tlialog. If any errors or warnings
occur, they will be displayed in the message tartiow.
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